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1. INITIAL SETUP

What You Need Before Starting
Before beginning your website project, ensure you have:

A domain name purchased and active (e.g., www.yoursite.com)

A hosting account (WordPress hosting provider)

Access to your WordPress admin dashboard

http://www.yoursite.com/


A modern web browser (Chrome, Firefox, Safari, or Edge)

Administrator access to your WordPress site

Logging Into WordPress

1. Open your web browser

2. Go to yoursite.com/wp-admin (replace "yoursite.com" with your actual domain)

3. Enter your username and password

4. Click "Log In"

5. You now see the WordPress Dashboard

Understanding the Dashboard Layout

Left Sidebar Menu: Contains all main functions

Dashboard (home page)

Posts (blog articles)

Pages (static pages like "About Us")

Appearance (themes, menus, customization)

Plugins (tools for your site)

Settings (general site settings)

Top Bar: Quick access and admin information

Shows your site name

Displays "View Site" button

Shows user profile and logout

Main Content Area: Changes based on what you click in the sidebar

2. INSTALLING YOUR THEME

What is a Theme?
A theme is a complete design template that controls how your entire website looks. It includes colors, fonts,
layouts, and styling. Think of it as buying professional interior design for your website.

Step-by-Step Theme Installation

Step 1: Navigate to Themes

1. Look at the left sidebar menu



2. Find "Appearance" and click it

3. A submenu appears with options

4. Click "Themes"

5. You see your current active theme and a gallery of available themes

Step 2: Search for Astra Theme (Recommended for Beginners)

1. Click the button labeled "Add New" (usually in the top area)

2. A search box appears at the top

3. Click in the search box

4. Type "Astra" and press Enter

5. The Astra theme appears in the results with a preview image

Step 3: Install the Theme

1. Hover your mouse over the Astra theme card

2. A button appears that says "Install"

3. Click "Install"

4. A loading animation appears (the site is downloading the theme files)

5. The button changes to "Activate"

Step 4: Activate the Theme

1. Click the "Activate" button

2. The page reloads

3. A success message appears: "Theme activated"

4. Your website now uses the Astra design

Customizing Basic Theme Settings

After activating your theme:

1. Click "Appearance" in the left sidebar

2. Click "Customize"

3. A customizer panel appears on the left

4. You see options like:

Site Title: Your business or website name



Tagline: A short description

Logo: Your business logo

Colors: Color scheme

Fonts: Typography choices

To make changes:

1. Click each section to expand it

2. Make your edits

3. See live previews on the right side of the screen

4. Click "Publish" to save permanently

3. INSTALLING REQUIRED PLUGINS

What are Plugins?

Plugins are software add-ons that extend your WordPress functionality. They're like apps on your phone—you
install them to add specific features.

Essential Plugins for Building
Plugin 1: Elementor (Page Builder)

Elementor is a drag-and-drop website builder that makes creating pages simple and visual.

Installation steps:

1. Click "Plugins" in the left sidebar

2. Click "Add New"

3. In the search box, type "Elementor"

4. Find "Elementor" by Elementor.com (the official version)

5. Click "Install Now"

6. Wait for the installation to complete

7. Click "Activate"

Plugin 2: Starter Templates

Starter Templates provides pre-designed website templates that you can customize.

Installation steps:

1. Click "Plugins" in the left sidebar



2. Click "Add New"

3. In the search box, type "Starter Templates"

4. Find "Starter Templates" by Brainstorm Force

5. Click "Install Now"

6. Click "Activate"

Removing Unnecessary Plugins
WordPress comes with pre-installed plugins you may not need. To remove them:

1. Click "Plugins" in the left sidebar

2. Click "Installed Plugins"

3. Look for plugins you don't want

4. Click the plugin name to select it

5. At the top, you'll see "Bulk Actions" dropdown

6. Select "Deactivate" and click "Apply"

7. After deactivation, the "Delete" option becomes available

8. Select "Delete" from Bulk Actions

9. Confirm deletion

4. BUILDING WITH STARTER TEMPLATES

Understanding Starter Templates

Starter Templates provide ready-made website layouts that you can customize. This saves tremendous time
compared to building from scratch.

Choosing Your Template
Step 1: Launch Starter Templates

1. After activating Starter Templates, you may see a "Get Started" button on your dashboard

2. Click "Get Started"

3. If you don't see this button, go to Appearance > Starter Templates in the sidebar

Step 2: Select a Page Builder

1. You're asked which page builder to use

2. Select "Elementor" (most beginner-friendly option)



3. Click "Continue"

Step 3: Browse Available Templates

1. You see various template categories:
Restaurant & Café

Portfolio & Agency

E-commerce & Shop

Blog & Magazine

Photography

Fitness & Wellness

Professional Services

And many more

2. Click a category that matches your business type

3. Browse the templates within that category

4. Read the descriptions to understand what each includes

Step 4: Select Your Template

1. Click on a template that appeals to you

2. You see a preview of how your site will look

3. Many templates are free; some are premium

4. Click the template name to select it

Step 5: Start the Installation

1. Click "Install" or "Continue"

2. The system asks you to select plugins needed

3. Most necessary plugins are pre-selected

4. Uncheck any you don't want

5. Click "Build My Website" or "Install"

Step 6: Wait for Installation

1. The system installs all files

2. A loading bar or spinner appears



3. This can take 2-5 minutes

4. Do not close the browser or refresh the page

Step 7: View Your Completed Site

1. Once complete, a "View Your Website" button appears

2. Click it to see your new website

5. UNDERSTANDING THE ELEMENTOR EDITOR INTERFACE

How to Access the Elementor Editor
Method 1: From Your Website

1. Visit your website (yoursite.com)

2. Make sure you're logged in (you see the WordPress admin bar at the top)

3. At the top of the page, look for "Edit with Elementor" button

4. Click it

5. The editor opens

Method 2: From WordPress Dashboard

1. Click "Pages" in the left sidebar

2. You see a list of all your pages

3. Hover your mouse over the page name

4. Options appear: "Edit," "Edit with Elementor," etc.

5. Click "Edit with Elementor"

The Elementor Editor Layout

Left Panel (Editing Options):

When you select an element, its settings appear here

Shows properties like color, size, text, spacing

Contains the content editing area

Has a "+" icon to add new elements

Center Area (Website Preview):

Shows your website as you're building it



This is where you click to edit elements

Shows real-time changes as you edit

Updates instantly without saving

Top Toolbar:

"Back" button (exit editor)

"Publish" or "Update" button (save changes)

"Undo/Redo" arrows (fix mistakes)

View options (desktop, tablet, mobile)

Right Panel (Element Library):

Shows available elements to add

Includes text, images, buttons, videos, forms, etc.

Drag elements to your page or click to add

Key Concepts: Containers, Rows, and Sections

Sections: The largest building blocks

Contain one or more columns

You can add background colors or images to the entire section

You can set width, padding, and spacing

Columns: Subdivisions within a section

A section can have 1, 2, 3, or more columns

Allows side-by-side layouts

Each column contains widgets

Widgets: The smallest building blocks

These are actual content elements: text, images, buttons, videos, etc.

Multiple widgets can stack vertically in a column

Each widget is independently editable

Visual Example of Structure:

┌─────────────────────────────────────┐┌─────────────────────────────────────┐

│          SECTION 1                   ││          SECTION 1                   │
├──────────────┬──────────────────────┤├──────────────┬──────────────────────┤



6. EDITING TEXT CONTENT

Understanding Text Elements

Text in Elementor comes in several forms:

Headings: Large titles (H1, H2, H3, etc.)

Paragraphs: Regular body text

Text Editors: Advanced text with formatting options

Editing Existing Text
Step 1: Click the Text to Select It

1. In the Elementor editor, locate the text you want to edit

2. Click directly on the text

3. The text becomes selected (you see a border around it)

4. The left panel shows the editing options

Step 2: Edit the Text Content

1. Click in the text area where it says the current text

2. The text is now in edit mode (you see a cursor)

3. Select all text: Press Ctrl+A (Windows) or Cmd+A (Mac)

4. Delete the selected text by pressing Delete

5. Type your new text

Step 3: Format Your Text In the left panel, you can:

Change font size: Look for a number field with "px" (pixels)

Change color: Click the color box and choose a new color

Make bold: Click the B (Bold) button

│   COLUMN 1   │    COLUMN 2          ││   COLUMN 1   │    COLUMN 2          │

│              │                      ││              │                      │

│ Heading      │ Image                ││ Heading      │ Image                │
│ (Widget)     │ (Widget)             ││ (Widget)     │ (Widget)             │

│              │                      ││              │                      │

│ Text         │ Button               ││ Text         │ Button               │

│ (Widget)     │ (Widget)             ││ (Widget)     │ (Widget)             │
└──────────────┴──────────────────────┘└──────────────┴──────────────────────┘



Make italic: Click the I (Italic) button

Alignment: Click left, center, or right alignment buttons

Text decoration: Add underline or strikethrough

Example: Editing a Heading
Original text: "Welcome to Our Restaurant"
Target text: "The Best Pizza in Town"

Steps:

1. Click on the heading text

2. In the left panel, find the text input field

3. Clear the old text: Ctrl+A, then Delete

4. Type "The Best Pizza in Town"

5. To make it larger: Find "Font Size" in the left panel

6. Change from 40px to 50px (or your preference)

7. To change color: Click the color circle

8. Select a new color from the color picker

9. Your heading updates in real-time

Adding New Text Elements
Step 1: Access the Element Library

1. Look at the bottom left of the editor

2. Click the "+" icon or "Add Element" button

3. A panel opens showing available elements

Step 2: Find and Add Text Element

1. Look for "Text Editor" or "Heading" in the element list

2. Click on it

3. The element is added to your page

Step 3: Edit the New Element

1. The element appears on your page with placeholder text

2. Follow the editing steps above to change the content



The left panel provides a "Content" tab where you can:

Font: Select from available fonts (Arial, Roboto, Open Sans, etc.)

Font Size: Adjust size in pixels (px)

Font Weight: Choose light, normal, bold, extra bold

Text Transform: Convert to UPPERCASE, lowercase, or capitalize

Line Height: Space between lines (useful for readability)

Letter Spacing: Space between letters

Text Shadow: Add shadow effects behind text

Text Stroke: Add outline around text

Advanced: Using the Full Text Editor
For complex text with multiple formatting options:

1. Add a "Text Editor" widget (not just "Text")

2. The editor opens with formatting toolbar

3. Similar to Microsoft Word formatting:

Bold, Italic, Underline buttons

Font selection dropdown

List options (bullets, numbers)

Link insertion

Text alignment

7. WORKING WITH IMAGES

Image Placement Best Practices
Before adding images, consider:

Size: Images should be 72 dpi for web (not 300 dpi for print)

Format: Use JPG for photographs, PNG for graphics with transparency

Dimensions: Optimize for web (typically 800-2000px width)

File size: Aim for under 300KB per image for faster loading



Method 1: Adding an Image Widget

Step 1: Insert Image Widget

1. Click the "+" button at the top left or bottom left

2. Search for "Image" in the element panel

3. Click "Image" to add it to your page

4. An image placeholder appears

Step 2: Upload or Select Image

1. Click on the image placeholder

2. In the left panel, find "Image" section

3. Click "Choose Image" button

4. A media library window opens showing:

Previously uploaded images

Option to upload new images

Step 3: Upload New Image (if needed)

1. Click "Upload Files" tab in the media window

2. Click "Select File" or drag an image into the upload area

3. Choose image from your computer

4. The image uploads and is selected automatically

5. Image appears on your page

Method 2: Adding Image to Existing Section

1. Click on the section where you want the image

2. Look for "Background" options in the left panel

3. Find "Background Type" dropdown

4. Select "Image" instead of "Color"

5. Click "Choose Image"

6. Select or upload your image

7. The image becomes the background of that section



After inserting an image:

1. Click the image to select it

2. In the left panel, look for "Size" section

3. Width: Enter desired width in pixels

4. Height: Enter desired height (or leave blank for proportional scaling)

5. Aspect Ratio: Lock aspect ratio toggle maintains proportions

Positioning Within Container:

1. With image selected, find "Alignment" in left panel

2. Choose: Left, Center, or Right

3. Find "Margin" to add space around the image

4. Find "Padding" to add space inside the image container

Overlaying Text on Images:

1. Add an image to a column

2. In the same column, add a text widget above or below the image

3. Add a "Button" or "Heading" widget

4. Text now appears with the image

5. Adjust positioning using alignment and spacing settings

Image Effects and Styling

Adding Image Effects:

1. Select your image

2. In left panel, look for "Effects" or "Image Effects"

3. Available effects:
Opacity: Make image semi-transparent (0-100%)

Brightness: Make lighter or darker

Contrast: Increase or decrease difference between light and dark

Saturation: Make more colorful or grayscale

Blur: Add blur effect



Hue: Shift color tone

Adding Borders to Images:

1. Select image

2. Find "Border" in left panel

3. Choose border style: Solid, Dashed, Dotted, Double

4. Set border width in pixels

5. Choose border color

6. Image now has a visible border

Adding Shadow to Images:

1. Select image

2. Find "Box Shadow" in left panel

3. Click to enable shadow

4. Adjust:
Horizontal offset

Vertical offset

Blur radius

Shadow color and opacity

5. Image appears to float above the page

Linking Images
Make images clickable:

1. Select the image

2. In left panel, find "Link" option

3. Click the link icon

4. Enter URL: www.example.com

5. Choose "Open in same tab" or "Open in new tab"

6. When visitors click the image, they go to that link

Image Captions
Add text below images:

http://www.example.com/


1. Select the image

2. In left panel, find "Caption" field

3. Type your caption text

4. Customize caption styling: color, size, alignment

5. Caption appears below the image

8. ADDING AND EDITING VIDEOS

Video Sources and Formats

You can embed videos from:

YouTube: Upload to YouTube, then embed on your site

Vimeo: Professional video hosting

Self-hosted: Upload video files directly to your site (not recommended for large files)

Local files: MP4, WebM, OGG formats

Adding YouTube Videos

Step 1: Prepare Your YouTube Video

1. Go to youtube.com

2. Upload your video (or use an existing video)

3. Once uploaded, copy the video URL from the address bar

4. Example: https://www.youtube.com/watch?v=dQw4w9WgXcQ

Step 2: Add Video Widget in Elementor

1. Click the "+" button to add a new element

2. Search for "Video" in the element list

3. Click "Video" widget

4. A video placeholder appears on your page

Step 3: Insert YouTube URL

1. Click the video placeholder or click on "Video" in left panel

2. Find "Video URL" field in the left panel

3. Paste your YouTube URL into this field

https://www.youtube.com/watch?v=dQw4w9WgXcQ


4. Press Enter

5. Video preview appears with play button

Step 4: Customize Video

1. Video Size: Set width (height auto-adjusts)

2. Aspect Ratio: Choose 16:9 or 4:3

3. Controls: Enable play, pause, volume controls

4. Autoplay: Automatically start playing (usually disabled)

5. Loop: Video repeats continuously (useful for background videos)

6. Mute: Start muted (required if autoplay is on)

Adding Vimeo Videos

Steps are identical to YouTube:

1. Upload video to Vimeo.com

2. Copy the video URL

3. Add Video widget in Elementor

4. Paste Vimeo URL into Video URL field

5. Customize settings as above

Self-Hosted Videos
For videos uploaded directly to your WordPress site:

Step 1: Upload Video File

1. Click "Media" in left sidebar

2. Click "Add New"

3. Click "Select File"

4. Choose MP4 video from your computer

5. Click "Open"

6. Video uploads to your server

Step 2: Add Video Widget

1. Click "+" to add element

2. Select "Video" widget



3. In the left panel, find "Video Type"

4. Select "Self Hosted" or "Local"

5. Click "Choose Video"

6. Select your uploaded video

7. Video appears on your page

Important Note: Self-hosted videos require server space and bandwidth. Large video files can slow your site.
It's better to use YouTube or Vimeo.

Positioning Videos

Full Width Video:

1. Select video element

2. Find "Width" option

3. Set to 100%

4. Video stretches across the page

Centered Video:

1. Select video element

2. Find "Alignment" in left panel

3. Choose "Center"

4. Video centers in its container

Side-by-Side Layout:

1. Create a section with 2 columns

2. Put video in left column

3. Put text in right column

4. Adjust column widths: 50% each, or 60%/40%

Video with Text Overlay
Create a video section with text on top:

1. Add section with image background (your video thumbnail)

2. Add video widget in the same section

3. Reduce video opacity to 50% (semi-transparent)



4. Add text widget above video

5. Style text with good contrast (dark text on light background, or vice versa)

Video Responsive Behavior
Videos automatically adjust for different screen sizes:

1. Select video element

2. At top of editor, click "Tablet" icon to see tablet view

3. Adjust width if needed

4. Click "Mobile" icon to see mobile view

5. Ensure video is readable and playable on small screens

9. ADDING AND EDITING AUDIO

Audio Options

You can add audio in several ways:

Audio player: Click to play, with volume and progress controls

Audio background: Plays quietly in the background

Embedded players: From Spotify, SoundCloud, etc.

Adding an Audio Player

Step 1: Prepare Audio File

1. Audio should be MP3 format (universal compatibility)

2. File size should be under 10MB (preferably under 5MB)

3. Test the file on your computer to ensure it plays

Step 2: Upload Audio File

1. Click "Media" in left sidebar

2. Click "Add New"

3. Click "Select File"

4. Choose your MP3 file

5. Click "Open"

6. Audio file uploads (this may take a minute for larger files)



7. Copy the file URL from the media library

Step 3: Add Audio Widget

1. Click "+" to add element

2. Search for "Audio" in the element list

3. Click "Audio" widget

4. An audio player placeholder appears

Step 4: Insert Audio File

1. Click on the audio widget

2. In left panel, find "Audio File" or "Media" section

3. Click "Choose Audio"

4. Select your uploaded audio file

5. The audio player now shows your file

6. Click play to test it works

Audio Player Customization

Playback Controls:

1. Select audio widget

2. In left panel, find "Controls"

3. Enable/disable options:
Play/Pause: Users can start and stop

Time Slider: Allows seeking through the audio

Volume: Users adjust volume

Download: Allows users to download the file

Styling the Player:

1. Find "Color" options in left panel

2. Progress Bar Color: Color of the playback progress

3. Buffered Color: Color of pre-loaded portion

4. Text Color: Color of time display

5. Background Color: Player background



Size and Display:

1. Find "Player Height" option

2. Increase or decrease player size (typically 40-60px)

3. Find "Width" option

4. Set to 100% for full container width

Using Third-Party Audio Platforms
SoundCloud Embed:

1. Go to soundcloud.com

2. Find a track you want to embed

3. Click the track to open it

4. Click "Share" button

5. Click "Embed"

6. Copy the embed code

7. In Elementor, add "SoundCloud" widget

8. Paste the URL or code

9. Player appears

Spotify Embed:

1. Go to spotify.com

2. Find a track, playlist, or album

3. Click the three dots menu

4. Click "Share" > "Copy Spotify URI"

5. In Elementor, search for "Spotify" widget

6. Paste the URI

7. Spotify player appears

Audio with Text Description
Create an audio section with information:

1. Create a section with 2 columns

2. Left column: Audio player



3. Right column: Text describing the audio
Title of the audio

Description or transcript

Additional information

4. Add "Read More" link if transcript is long

Making Audio Accessible

Best Practices:

1. Always provide a transcript of audio content

2. Use captions for video with audio

3. Allow users to download the file

4. Test audio on different browsers

5. Use clear labeling: "Listen to [topic]"

10. POSITIONING AND STYLING ELEMENTS

Understanding the Layout System
Elementor uses a responsive grid system:

Desktop: Default view (1024px and wider)

Tablet: Medium screens (768px to 1023px)

Mobile: Small screens (below 768px)

Alignment Options

Horizontal Alignment (Left to Right):

1. Select any element

2. Find "Alignment" in left panel

3. Choose: Left, Center, or Right

4. Element shifts to the chosen position

Vertical Alignment (Top to Bottom):

1. More complex, varies by element type

2. For text: Select, find "Text Align," choose top, middle, bottom

3. For containers: Find "Vertical Align" in the section settings



Spacing: Margin and Padding

Margin: Space outside the element (pushes other elements away) Padding: Space inside the element (pushes
content away from edges)

To Adjust Margin:

1. Select element

2. Find "Margin" in left panel (usually under Advanced or Spacing)

3. Set values for Top, Bottom, Left, Right

4. Values are in pixels (px)

5. All four sides can have different values

Example: Margin 20px top creates 20px space above the element

To Adjust Padding:

1. Select element

2. Find "Padding" in left panel

3. Set values for all four sides

4. Padding creates internal spacing

Quick Spacing:

1. Click the small icon (usually "S" or box icon) next to Margin/Padding

2. Choose "Link" to apply same value to all sides

3. Enter one value for all sides: Top, Bottom, Left, Right all become equal

Width and Height Control

Setting Width:

1. Select element

2. Find "Width" option

3. Choose:
Specific pixels: 300px

Percentage: 50% (half container)

100% (full container)

Auto (natural size)

Setting Height:



1. Select element

2. Find "Height" option

3. Choose:
Specific pixels: 400px

Auto (content determines height)

Minimum height: Element stretches to fill space if needed

Example: Creating Equal-Width Columns

1. Section with 3 columns

2. Each column set to width: 33.33%

3. All columns now have equal width

Positioning Elements Within a Section

Using Flexbox Alignment:

Modern Elementor uses Flexbox for alignment. This controls how elements stack and align.

1. Click on the section or container

2. Find "Layout" or "Direction" in left panel

3. Choose:
Direction: Row (left to right) or Column (top to bottom)

Align Items: Controls vertical alignment (top, center, bottom)

Justify Content: Controls horizontal alignment (left, center, right, space-between)

Practical Example: Center Content Horizontally and Vertically

1. Click section containing your elements

2. Set Direction: Row

3. Set Justify Content: Center

4. Set Align Items: Center

5. All elements in that section center both ways

Layering Elements (Z-Index)
When elements overlap, Z-index determines which appears on top.

1. Select the element you want on top



2. Find "Advanced" tab in left panel

3. Look for "Z-Index"

4. Higher numbers appear on top

5. Example: Element A (z-index: 10) appears over Element B (z-index: 5)

Creating Responsive Designs
Edit for Different Screen Sizes:

1. At the top of Elementor editor, see three icons: Desktop, Tablet, Mobile

2. Click "Tablet" to see how your site looks on tablets

3. Make adjustments:
Reduce image width

Stack columns differently

Adjust font sizes

4. Click "Mobile" to see smartphone view

5. Make further adjustments
Stack everything vertically

Simplify layout

Increase touch targets (buttons need to be big)

Example: Responsive Image Adjustment

Desktop: Image width 50%

Tablet: Image width 60% (more visible)

Mobile: Image width 100% (full screen)

To make these changes:

1. Select image

2. Click Tablet view

3. Change width to 60%

4. Click Mobile view

5. Change width to 100%

6. Different widths apply to each device size



Using Flexbox for Complex Layouts

Creating a "Card" Layout:

A card is a box containing an image, text, and button.

1. Create section with 3 columns (side by side)

2. In first column:
Add image at top

Add heading below

Add description text

Add button at bottom

3. Set column padding: 20px on all sides

4. Add background color to column

5. Add border radius: 10px (rounded corners)

6. Add shadow for depth

7. Repeat for other columns

8. Now you have three equal "cards" side by side

11. CREATING NEW PAGES

Understanding Pages vs. Posts

Pages: Static content that doesn't change much

About Us

Contact

Services

Team

FAQ

Posts: Blog articles with dates

News updates

Blog articles

Announcements



Creating a New Page

Step 1: Access Pages

1. Click "Pages" in left sidebar

2. Click "Add New"

3. A new page editor opens

Step 2: Name Your Page

1. At the top where it says "Enter page title here"

2. Type your page name: Example: "Our Team"

3. This becomes the page heading

Step 3: Edit the Page URL (Optional but Recommended)

1. Look at the right panel (usually labeled "Document" or "Settings")

2. Find "Permalink" or "URL"

3. Click "Edit" next to the URL

4. Clean up the URL to be short and meaningful

5. Example: "our-team" instead of "our-team-automatically-generated"

6. Click "OK"

Step 4: Choose Page Template (if available)

1. Look in right panel for "Template" or "Layout"

2. Some themes offer different page templates

3. Choose one that fits your needs

4. Select and it applies to your page

Step 5: Edit Page Content with Elementor

1. Click "Edit with Elementor" button

2. Elementor editor opens

3. Delete placeholder content if any

4. Use "+" button to add sections, columns, and widgets

5. Build your page using text, images, videos, buttons, forms, etc.



Quick Page Building Steps

For a Simple Contact Page:

1. Add Heading: "Contact Us"

2. Add Text: "We'd love to hear from you. Contact information:"

3. Add Contact Form or manually add:

Address

Phone number

Email address

4. Add an image related to contact

5. Add a map (Google Map widget)

6. Add call-to-action button: "Send Message"

For a Service Page:

1. Add Heading: "Our Services"

2. Add 3-column section with "cards"

3. Each card:
Icon or image

Service title

Short description

"Learn More" link

4. Add full description section below

5. Add testimonials or case studies

6. Add call-to-action button

Page Settings Before Publishing

Before publishing your page:

1. Right panel: Find "Visibility"

2. Ensure it's set to "Public" (not Draft or Private)

3. Find "Featured Image" (optional)

4. This appears in page previews and social sharing



Publishing Your Page

1. Click the blue "Publish" button (top left in Elementor)

2. If it's a new page, it says "Publish"

3. If editing existing page, it says "Update"

4. Page is now live on your website

5. Click "View Page" to see your published page

12. BUILDING NAVIGATION MENUS

Understanding Navigation Structure
Navigation menus help visitors find pages on your site. Most websites have a main menu at the top.

Creating a Navigation Menu

Step 1: Access Menu Settings

1. Click "Appearance" in left sidebar

2. Click "Menus"

3. Click "Create a new menu"

4. Name your menu: Example: "Main Menu"

5. Click "Create Menu"

Step 2: Add Pages to Menu

1. On the "Edit Menu" page

2. Look for "Add items to menu" on the left

3. Click "Pages"

4. All your pages appear

5. Check the pages you want in your menu

6. Click "Add to Menu"

7. Pages now appear in the menu structure

Step 3: Arrange Menu Items

1. Drag and drop menu items to reorder them

2. Recommended order:

Home (first)



About Us

Services or Products

Contact

3. Drag items slightly to the right to create submenus

4. Example: Services menu with sub-items: Consultation, Training, Support

Step 4: Assign Menu to Location

1. Find "Display location" section

2. Check "Primary Menu" (or "Header Menu")

3. This displays your menu in the header of your site

4. Click "Save Menu"

Editing Menu Items
Adding Custom Links:

Sometimes you want to link to external websites, not just your pages.

1. In menu editor, look for "Custom Links"

2. Enter URL: www.externalsite.com

3. Enter Link Text: "External Site Name"

4. Click "Add to Menu"

Changing Menu Item Labels:

1. In menu editor, find the menu item

2. Click the arrow to expand it

3. Edit the label/name

4. This doesn't change the page name, just how it appears in the menu

Creating Dropdowns (Submenus):

1. In menu editor, select a menu item

2. Drag it slightly to the right, under another item

3. It becomes a submenu (appears when you hover)

4. Example structure:
Services (main)

http://www.externalsite.com/


├─ Consultation (submenu)

├─ Training (submenu)

└─ Support (submenu)

Managing Multiple Menus

You can create different menus for different locations:

1. In "Menus" page

2. Create multiple menus

3. Example menus:
Main Menu (header)

Footer Menu (footer links)

Secondary Menu (sidebar)

4. Assign each to its designated location

Header Menu Visual Example

13. CUSTOMIZING HEADER AND FOOTER

Understanding Header and Footer
Header: Top section of every page

Contains logo

Contains main navigation menu

May contain search bar

May contain contact info

Footer: Bottom section of every page

Copyright information

┌────────────────────────────────────────┐┌────────────────────────────────────────┐

│ Logo    │ Home  About  Services  Contact││ Logo    │ Home  About  Services  Contact│

└────────────────────────────────────────┘└────────────────────────────────────────┘

                    └─ When you hover "Services":└─ When you hover "Services":
                          ├─ Consultation├─ Consultation

                          ├─ Training├─ Training

                          └─ Support└─ Support



Links to important pages

Contact information

Social media links

Newsletter signup

Customizing the Header
Step 1: Access Header Settings

1. Click "Appearance" in left sidebar

2. Click "Customize"

3. In the left panel, find "Header" or "Site Title & Logo"

4. Click to expand

Step 2: Add Logo

1. Find "Logo" section

2. Click "Select Logo"

3. Choose or upload your logo image (PNG with transparent background recommended)

4. Adjust logo size if needed

5. Your logo now appears in the header

Step 3: Change Site Title

1. Find "Site Title" field

2. Change from "My Site" to your business name

3. Choose to display title in header (toggle "Display site title")

Step 4: Edit Header Directly (Advanced)

1. If you want to edit header layout in detail

2. On your website (logged in), go to header area

3. Hover over header

4. Click the pencil/edit icon if it appears

5. Edit header like any other Elementor section

6. Change background, add widgets, rearrange content

7. Click Publish



Customizing the Footer

Step 1: Access Footer Settings

1. Click "Appearance" in left sidebar

2. Click "Customize"

3. Find "Footer" in the left panel

4. Click to expand

Step 2: Edit Footer Content

1. Find "Footer Text" or "Copyright Text"

2. Change the copyright information:
Original: "© 2024 My Site"

Change to: "© 2024 Your Business Name. All rights reserved."

3. Find "Footer Widgets" or "Footer Columns"

4. Choose how many columns: 1, 2, 3, or 4

5. Each column can contain widgets

Step 3: Add Footer Information

1. Usually footer is divided into columns

2. Column 1: Company info and address

3. Column 2: Important links (Privacy, Terms, Sitemap)

4. Column 3: Contact information

5. Column 4: Social media links

Step 4: Add Social Media Icons to Footer

1. In footer editor, look for "Social Icons" widget

2. Add social media icons: Facebook, Twitter, Instagram, LinkedIn

3. Enter links to your social media profiles

4. Icons appear in footer with links

Step 5: Edit Footer with Elementor (Advanced)

1. Go to your website

2. Scroll to bottom (footer area)



3. Hover over footer

4. Click pencil icon to edit

5. Add widgets: Text, Images, Buttons, Forms

6. Edit footer styling: colors, background, spacing

7. Click Publish

Footer Widget Example

A well-organized footer typically contains:

14. PUBLISHING AND SAVING YOUR WORK

Understanding Different Publish States
Draft: Page saved but not visible to public

You can edit without affecting live site

No one sees it except you

Scheduled: Page set to publish at future date/time

Useful for announcements

Blog posts can go live automatically

Published: Page is live and visible to everyone

Anyone visiting your site can see it

Search engines can index it

┌─────────────────────────────────────────┐┌─────────────────────────────────────────┐
│  ABOUT            │ LINKS           │ CONTACT│  ABOUT            │ LINKS           │ CONTACT

│  Your business    │ Home            │ 123 Main St│  Your business    │ Home            │ 123 Main St

│  description      │ About           │ (555) 555-1234│  description      │ About           │ (555) 555-1234

│  and mission      │ Services        │ email@example.com│  and mission      │ Services        │ email@example.com
│                   │ Contact         ││                   │ Contact         │

├────────────────────────────────────────┤├────────────────────────────────────────┤

│ © 2024 Your Business Name. All rights  ││ © 2024 Your Business Name. All rights  │

│ reserved.                               ││ reserved.                               │
│ Privacy Policy | Terms of Service       ││ Privacy Policy | Terms of Service       │

└────────────────────────────────────────┘└────────────────────────────────────────┘



Saving Your Work

In Elementor Editor:

You have two main save options:

1. Save (Autosave): Elementor saves your work automatically
Works in the background

No action needed

Saves every minute or so

2. Publish/Update: Make changes visible to the world

Click blue "Publish" button (new page) or "Update" button (existing page)

This is what makes changes live

Always click this when done editing

Visual Guide:

Publishing Pages
For New Pages:

1. Click the blue "Publish" button

2. Dialog appears asking about visibility

3. Choose "Public" (not Private or Draft)

4. Click "Publish" in the dialog

5. Page is now live

6. You see "View Page" option

For Existing Pages:

1. Make your edits in Elementor

2. Click "Update" button (not Publish)

3. Changes are saved

Top Left of Elementor Editor:Top Left of Elementor Editor:

┌─────────────┬────────┬──────────┐┌─────────────┬────────┬──────────┐
│ ← Back      │ Undo ↻ Publish → ││ ← Back      │ Undo ↻ Publish → │

└─────────────┴────────┴──────────┘└─────────────┴────────┴──────────┘

                            Click this when doneClick this when done



4. Page is automatically live (if it was already published)

Scheduling Future Publication

To set a page to publish later:

1. Before publishing, click "Publish" button

2. In the dialog, find "Publish date/time"

3. Choose a future date and time

4. Click "Schedule" instead of "Publish"

5. Page will automatically go live at that time

Managing Published vs. Draft Pages

Viewing All Pages:

1. Click "Pages" in left sidebar

2. See list of all pages

3. Status column shows: Draft, Published, Scheduled

4. Published pages have a green checkmark or "Published" label

Reverting to Draft:

1. Open a published page

2. Click "Status: Published" (in right panel)

3. Change to "Draft"

4. Click "Save Draft"

5. Page becomes private again

Creating Backups Before Major Changes

Best Practice: Create backup before major editing

1. Before starting big changes, take a screenshot of your page

2. Or use a plugin like "UpdraftPlus" (available in Plugins > Add New)

3. Install and activate UpdraftPlus

4. It backs up your entire site automatically

5. If something goes wrong, you can restore the backup



15. TROUBLESHOOTING COMMON ISSUES

Issue: Page Not Showing Changes After Publish

Problem: You click Publish but changes don't appear on live site.

Solutions:

1. Wait a moment: Changes can take 5-10 seconds to appear

2. Hard refresh: Press Ctrl+Shift+R (Windows) or Cmd+Shift+R (Mac)
This clears your browser's cache

Forces reload of latest version

3. Clear browser cache:

Chrome: Settings > Privacy > Clear Browsing Data

Select "Cached Images" and "Cookies"

Click Clear Data

4. Check page visibility:
Open page in edit mode

Right panel > Status should be "Published"

Not "Draft" or "Private"

Issue: Images Not Displaying

Problem: Images show as broken or don't appear.

Solutions:

1. Check image file: Original file may be deleted
Upload image again

Click image > Select new image from media library

2. Check file permissions: Hosting server permissions issue

Contact your hosting provider

Tell them: "Image files in wp-content/uploads are not displaying"

3. Check file size: Image too large
Use image compression tool (TinyPNG.com)

Compress before uploading

Target: under 300KB per image



4. Wait for upload: Large images take time
Refresh page after 1 minute

Check if upload finished

Issue: Text Formatting Not Working

Problem: Text appears different than what you set.

Solutions:

1. Check plugin conflicts:
Disable all plugins except Elementor

If it works, a plugin is causing issue

Enable plugins one by one to find culprit

2. Check theme compatibility:

Update your theme to latest version

Go to Appearance > Themes

Click "Updates" if available

3. Clear theme cache:
Hosting providers often have built-in cache

Disable cache temporarily:
Most hosts have cache clearing button in control panel

Or contact support to clear cache

Issue: Video Not Playing

Problem: Video player appears but won't play.

Solutions:

1. Check video URL: YouTube/Vimeo URL might be wrong
Go to YouTube/Vimeo

Get fresh URL from address bar

Paste into Video URL field again

2. YouTube video blocked: Video might be set to private

Go to YouTube

Click "Share"



Ensure it's not "Private"

Change to "Public" or "Unlisted"

3. Check browser compatibility:
Try different browser: Chrome, Firefox, Safari

Update your browser to latest version

4. Self-hosted video issues:
Upload to YouTube instead (easier and faster)

Remove self-hosted video

Add YouTube version instead

Issue: Mobile Site Looks Bad
Problem: Site looks great on desktop but terrible on mobile.

Solutions:

1. Test on actual devices:

Don't just use browser's mobile preview

Test on actual smartphone if possible

Borrow friend's phone if needed

2. Fix mobile layout:
In Elementor, click "Mobile" view

See how it looks on small screen

Make adjustments:

Stack columns vertically (set each column to 100% width)

Reduce font sizes slightly

Increase spacing between elements

Make buttons bigger (easier to tap)

3. Test touch interaction:

Buttons need minimum 44px height for comfortable tapping

Spacing between buttons prevents accidental clicks

4. Check plugin settings:

Some plugins have mobile-specific settings



Go to Plugins > Settings (if available)

Look for "Mobile" options

Issue: Slow Loading Speed
Problem: Website takes too long to load.

Solutions:

1. Compress images:

Images are usually the problem

Use TinyPNG.com or Smush.it

Compress all images before uploading

2. Delete unused content:
Remove old images not used on site

Delete draft posts/pages

Go to Media > Library

Delete unused files

3. Disable unused plugins:
Every plugin slows site slightly

Keep only essential plugins

Deactivate and delete others

4. Enable caching:
Install "WP Super Cache" plugin

Caching stores copies of pages

Serves them faster to visitors

Dramatically improves speed

5. Use a CDN (Content Delivery Network):
CDN stores copies of images on servers worldwide

Users get images from server closest to them

Makes load times faster globally

Cloudflare offers free basic CDN



Issue: Menu Items Not Appearing

Problem: You added pages to menu but they don't show up.

Solutions:

1. Check menu assignment:
Appearance > Menus

Look at bottom: "Display location"

Ensure your menu is assigned to "Primary Menu" or "Header Menu"

2. Check menu visibility:

Appearance > Customize

Look for "Menu" settings

Ensure menu is set to "Display"

3. Save menu:
After changes, click "Save Menu"

Without saving, changes don't apply

4. Check theme support:
Some themes don't support menus well

Try switching to Astra theme (has excellent menu support)

Issue: Page Settings Not Saving

Problem: You change settings but they revert to defaults.

Solutions:

1. Click Save/Publish: Make sure to click the button
Don't just refresh the page

Must explicitly click Save or Publish

2. Check user permissions:

Log out and log back in

Sometimes session expires

Logging back in refreshes permissions

3. Plugin conflict:
Deactivate all plugins



Try saving settings

If it works, enable plugins one by one

Find which one causes issue

Issue: Can't Access WordPress Dashboard

Problem: You're locked out of your own site.

Solutions:

1. Clear cookies:
Browser > Settings > Clear Browsing Data

Select "Cookies"

Try logging in again

2. Try incognito/private browsing:

Chrome: Ctrl+Shift+N

Firefox: Ctrl+Shift+P

Log in from incognito window

Sometimes regular browsing has issues

3. Reset password:

Go to site.com/wp-login.php

Click "Lost your password?"

Enter email address

Check email for reset link

Follow link to set new password

4. Contact hosting support:
If still locked out, hosting company can help

They can reset your account

Or temporarily grant you access

BEST PRACTICES SUMMARY

Building High-Quality Websites
Content Best Practices:



Write clear, concise content (avoid jargon)

Use headings to organize content

Keep paragraphs short (3-4 sentences)

Use images to break up text

Proofread for spelling and grammar

Design Best Practices:

Use consistent colors throughout

Font should be readable (avoid fancy fonts)

Don't use more than 3 different fonts

Adequate spacing between elements

Align elements for organized appearance

Mobile Best Practices:

Always check mobile appearance

Ensure buttons are large enough to tap

Test on actual smartphones

Keep mobile navigation simple

Images should scale properly

Performance Best Practices:

Compress all images before uploading

Keep file count to minimum

Disable unused plugins

Enable caching

Test loading speed regularly

Security Best Practices:

Keep WordPress updated

Keep plugins updated

Use strong passwords

Enable regular backups



Consider SSL certificate (HTTPS)

Maintenance Schedule

Weekly:

Check website appearance

Test all links work

Review page content for accuracy

Monthly:

Update WordPress core

Update all plugins

Update theme if available

Review analytics if installed

Backup your site

Quarterly:

Review and update old content

Remove unused pages or plugins

Check for broken images

Update copyright year (annually)

FINAL NOTES
Building a website is a skill that improves with practice. Don't be afraid to experiment, as Elementor makes it
easy to undo changes. Start with simple layouts and gradually add more complex features as you become
comfortable.

Remember: The best website is one that clearly communicates your message to your visitors. Focus on content
and user experience rather than overly complex design.

If you need help, most issues can be solved by:

1. Searching Google for the problem

2. Checking Elementor's documentation (elementor.com/help)

3. Asking in WordPress forums

4. Contacting your hosting provider for technical issues



Happy building!

APPENDIX: KEYBOARD SHORTCUTS
Windows:

Ctrl+S: Save

Ctrl+Z: Undo

Ctrl+Y: Redo

Ctrl+A: Select All

Ctrl+C: Copy

Ctrl+V: Paste

Ctrl+X: Cut

Ctrl+Shift+R: Hard Refresh (clear cache)

Mac:

Cmd+S: Save

Cmd+Z: Undo

Cmd+Y: Redo

Cmd+A: Select All

Cmd+C: Copy

Cmd+V: Paste

Cmd+X: Cut

Cmd+Shift+R: Hard Refresh (clear cache)

Document Version: 1.0 Last Updated: 2024 Compatible With: WordPress 6.x, Elementor 3.x, Astra Theme
4.x


